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SECTION 1: SYSTEM SETUP

1.1 Introduction

	Welcome to the Newage Testing Instruments'  C.A.M.S.®_WIN Program  Windows-based image 
acquisition and measurement software for C.A.M.S.® (Computer Optical Measurement System) and 
for other metallographic measurement needs.  This system, composed of hardware and software, 
was developed to enhance the capabilities of your microhardness tester by allowing you to improve 
or optionally automate the measurement of test impressions, reduce operator influence on test 
results, and transfer test results directly to a PC for real time, on-screen data management.

It is assumed that the operator has a basic understanding of Windows operating system and of PCs.  

	The B.O.S.S. computer program is file based.  All setup parameters (such as hardness scale, 
tolerance limits, part information, etc.) are saved with the data file that contains the test results.

1.2 What’s Included

The complete C.A.M.S.®_WIN package consists of :
1 - 3.5” Program Diskette
1 - CD-rom program disk
1 - Video camera and possibly an adapter for attachment
1 - Video Acquisition Board with connectors
1 - Operation Manual
1 - Computer System with monitor (unless supplied by customer)

OPTIONALLY
- Self leveling vise
- Other options for automating microhardness testing.

1.3 Minimum System Requirements

Pentium or Celeron processor running WindowsXP Professional® or Windows2000® with at least a 
1.7 GHz operating speed, available PCI slot, two available serial com ports, any size hard drive, USB 
II, VGA color monitor, video card with “Direct Draw” capability, 3.5” high density floppy drive (non 
mandatory), CD ROM, keyboard and mouse.  Please note that an incompatibility may exist between 
our software / hardware and some brands of computer.  For best results provide a Dell® brand PC or 
check with the factory on the compatibility of your computer prior to sending it in

			 

1.4 Principles of Operation

The Newage Instruments C.A.M.S. Computer Assisted Measuring System uses a video camera 
connected to a PC to view and optionally measure test impressions made by a microhardness tester.  
It operates independently of the tester that it is connected to.   The PC‑does not need to control any 
of the mechanical or electronic functions of the hardness tester itself, although it may be setup to do 
so, as well as controlling other provided components.  Please refer to the following sections for tester 
setup and operation.  

C.A.M.S. may be used in either manual or automatic measuring mode.  In manual mode, the operator 
locates the tips of the impressions by positioning measuring points on the monitor screen which the 
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program uses to calculate hardness values or measurement.  In automatic mode, the system scans 
the impression and located the measuring points automatically .  The accuracy achieved, especially in 
the optional automatic measuring mode, can be greatly influenced by the surface  condition of the 
test piece as it would for standard optical testing.  The reflective properties of the material, grinding 
marks, scale, etc, may affect the performance of the system in the automatic mode as well as the 
operator’s ability to determine accurate measuring points in the manual mode.  A polished surface will 
yield the best results.

1.5  C.A.M.S.  Hardware Installation 

1.5.1 C.A.M.S. Camera Installation:      

1.5.1.1 Testers with Camera Port

1) Access the tester's video camera mounting port.

2) Install the camera adapter. (Installation on field units may 
require drilling & tapping of mounting holes.)

3) Mount the camera into the bracket so that the camera 
model number, is "right side up" (so you can read it.)  
The camera should be "square" to the rest of the tester 
for proper image alignment.

4) Final alignment of the camera can be performed with a 
test impression on the PC screen in the Test mode.  
See the following operation section for further 
instructions.

1.5.1.2 Testers with Eyepiece Only

1) Install the camera adapter over the tester eyepiece.  
Position it so that the thumbscrew is to the left or right 
side.

2) Mount the camera into the adapter so that the camera 
model number,  is "right side up" (so you can read it.) The 
camera should be "square" to the rest of the tester for 
proper image alignment.

3) Final alignment of the camera can be performed with a test 
impression on the PC screen in the Test mode. Loosen the 
thumbscrew to move the eyepiece adapter clockwise or 
counter-clockwise.  See the following operation section for 
instructions for the Test mode.

TYPICAL INSTALLATION WITH 
EYEPIECE ADAPTER

CAMERA

ADAPTER

CONNECTS TO  COM-
PUTER

TYPICAL INSTALLATION WITH 
EXISTING CAMERA PORT

CAMERA

MOUNTING 
PLATE

CONNECTS TO  COM-
PUTER
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1.5.1.3 Connections

1) Attach all power and connecting cables as shown below:  NOTE: The video system uses 2 
connectors that plug into the back of the PC.  The main connector goes to the camera and 
has a jumper connector that is plugged in below it.

 

NOTE:‑Computer Connectors May Vary.

BACK VIEW OF PC Monitor connects 
to standard VGA connection

500 SERIES SYSTEM C.A.M.S.  cable connects to 
15 pin connector video card

Adapter cable 
connects to 
C.A.M.S. camera
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1.6 C.A.M.S. Software Installation (with NTSC Camera Systems)

1.6.1 Windows 2000 or XP

NOTE: INSTALL THE SOFTWARE BEFORE INSERTING THE CARD INTO CPU.

1)	 To install the CAMS_WIN program, run the “setup.exe” file on the installation CD.  The 
prompts will guide the entire process.  At the end there will be a prompt to insert a diskette in 
drive A:\ which contains setup, calibration information, and updates to the program. The 
installation program creates a folder “Newage Testing Instruments” with the proper Icon in it 
and also places the same icon on the desktop for easy program start.

2)	 Update the Register: the file needed is on the “Drivers” folder on the installation CD.  Run 
klinset.exe.  Follow the prompts and select 340 as the address and OK to Reboot the 
Computer.

3)	 When the system comes back at the desktop, shut it down, insert the Video Acquisition Card 
into an available PCI Slot and turn the Computer ON.  When windows finds the card and 
asks for the driver, browse and point to the “Drivers” folder on the installation CD which 
contains the proper driver (mv5w2k.inf).  When done check in Control Panel for the proper 
functioning of the Video Acquisition Card - it is in the group Sound and Video or multimedia.  
Its Interrupt should not be the same as other sound, video or network cards, ideally it should 
be 9, 10 or 11. If the device has a question mark or an exclamation mark, select it, click on 
remove then refresh. When it finds it again, select the “Drivers” folder on the installation CD as 
the source for the driver. If the conflict persist, try moving the board to a new slot or change 
or disable another device like the sound card or USB that uses the same interrupt.

1.6.2 Testers Communications

If the system includes a tester connected via the serial port COM1, in the Control Panel, the 
FIFO box should be unchecked.  The FIFO box is found in the Control Panel, System, Device 
Manager, Ports (COM & LPT) Com1, Port Settings, Advanced. 

1.6.3 Make an Install/Recovery Diskette

After the system is working properly, the final setup files along with Calibration data can be 
saved to the Install/Recovery Diskette wit the command Cback.bat.  This batch file copies all the 
pertinent files to the diskette.  Using Windows Explorer, view the contents of the C:\MT92VW 
folder and run the file check.bat.  A DOS window opens with the prompt to continue.  Insert the 
diskette in drive A: and press any key and the program does the backup.

NEWAGE C.A.M.S. PROGRAM  ICON
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1.6.4 DirectX 8.1

If the computer does not have Microsoft DirectX 8.1 software installed and the program requires 
it, DirectX  8.1 is available on the CD; it can be installed by running the setup file from the folder 
DirectX8.1

1.6.6 Security Lock Installation

1.6.6.1 USB Key

If the system has a USB Security Lock (Green Key), the drivers for the USB KEY are 
installed as part of the program installation.  Insert the Key, choose the automatic mode, 
and Windows will display the USB KEY found.  Before running the Application, run the 
Usbkey.reg file found on the CD in the folder KeylockUSB: this will update the registry to 
search for the lock on the USB ports.  Should the system have difficulties installing the 
drivers, additional drivers for the key are in the folder KeylockUSB.

Note: Plug the Key into all SB ports and install the drivers at this time.  Each USB port need 
the driver installed.

1.6.6.1 Parallel Port Key

If the system has a Parallel Security Lock (Black Dongle), the software for it must be 
installed; the files are on the floppy disk labelled Keylock or in the folder "Keylockparallel" on 
the installation CD Run the setupkey.exe file first, follow the prompts, then when done, run 
the file Everkey.reg, also from the folder "key" on the installation CD.  This will update the 
registry for the lock on LPT1

1.7 Computer Operating System Setup

1) The system works best with the video resolution set to:  800 x 600 with High Color (16  bit).   The 
'Small Fonts' setting must be selected under the Display Properties, Settings screen.

 

1.8 Initial Software Startup

1) Double click the icon to start the program. 

2) The program will open up using the last data storage file that was in use for holding test results.  If 
no data files have been created,  the operator can create a new file.  (See Sec 2.1 Create a New 
File.)  Hardness test results are added to the current open data file.
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SECTION 2: MENU BAR - FILE HANDLING FUNCTIONS

NOTE BEFORE PROCEEDING:  This manual is organized to give the operator instructions to install 
and use the C.A.M.S. system as quickly as possible.  To begin using the unit, read through the 
manual briefly to get an overview.  Then start here with Section 2 to begin actually using the system.

Optional hardware or software options are indicated.  If an option is not available, it may be 
purchased from Newage.  Call customer support at 215-526-2200.

The Main Menu Bar at the top of the screen contains 5 selections: File, View, Setup,  Data, and Help.   In 
order to best develop the operator's understanding of the system in a sequential manner, the "File" Main 
Menu selection is described in this section and the rest of the Main Menu selections in Section 4.

The File submenu selections consist of 7 different functions: New, Open, Close, Print, Print Preview, Print 
Setup, and Exit, as well as a listing of the last four files that have been in use. They can be accessed with 
the mouse by  clicking on  "File" and dragging down to the selection and selecting the desired file function.  

2.1 Create a New File

1) Select "New" from the File menu in the main menu at the top of the screen.  The "Create a New 
Test File" dialog box will appear.

2) Type in the name of the file using the .csv extension and select the OK button (or press Enter.)

3) The operator is prompted for what set of parameters to use.  The operator can select "Use 
Current Parameters" to enter the file parameters from the most recently used file and then 
prompted for a new comment to further identify this file.  If the operator selects "Enter New 
Parameters", a completely new set of parameters can be set up.   The final selection is "Retrieve 
Parameters" (optional - appears grayed out when not activated).  When activated a prompt 
appears to enter the file name from which to retrieve the parameters.  Then the operator can enter 
a new comment for this selection.  
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	 If the "Enter New Parameters" selection has been chosen, the operator will then be prompted for 
"Data Part File Information".  This information can be used to keep track of Part Number,  
Description, Order Number, Comments, etc., related to the data file just created.  These headings 
will appear on printouts.  Data entry is not required.  Select OK when done.

		 Clicking on the checkbox for "Prompted" will cause this screen to appear after each test so the 
operator can enter relevant data.  This function pertains only to single point testing - not traverses. 
Selecting "Sort by Prompt" will sort data in the printouts by the prompts so commented data can 
be readily identified.  Also see section 3.2.1 for entering comments only for out of tolerance results

	 The operator may create custom headings by selecting the "Field Names" button, (See graphic 
below) highlighting the name you wish to change, and typing in the new heading.  To make the 
new headings you’ve typed the default headings for all new files you create, select Change 
Defaults.  "Use Defaults" will revert changed headings to the current default headings.  (See 
graphic below)
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4) The next setup box is "Select a New Scale".  Choose one of the primary scales listed on the left by 
highlighting it with the mouse.   For most microhardness testing the selection would be HV (for 
Vickers scale) or HK (for Knoop scale).  If you would like the test result to also be converted to 
another scale and shown in addition to the selected scale, highlight one of the converted scales 
listed on the right.  For standard testing the radio button INCH/MM mode must be selected.  See 
appendices for use in Metallogaph Mode.   Select OK when done. 

	 The  scale abbreviations which may be listed are:

HV = Vickers Scale  
	HK = Knoop Scale 
	DIAG = Verification Program (Optional, See Appendices)
	HB = Brinell Scale for BOSS
	INCH = Measurement in Inches for linear measurement
	MM = Measurement in Millimeters for linear measurement
Kic = Fracture Toughness
	HRC, HRB, HRA, HR15N, etc = Rockwell C, B, A, 15N scale, etc.
		

	 NOTE:  The scale cannot be changed for a data file that contains test results.  The operator will 
be prompted to change files if he tries to change scales with data in the file.

5) After selecting the scale the operator is prompted to selected the "Average" option.  If available, 
the operator may select to record averages of multiple tests rather than the individual tests - See 
section 4.2.1 for more detail.  Otherwise the operator may select "OK" to move to the next setup 
functions.
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6) After the averaging screen, the operator is prompted for "Set Tolerances".  
The program uses these tolerance and warning settings for statistical 
calculations and for HI, LO, and OK indications for individual test results 
(but not for the traverse results - which can have tolerances created in 
"traverse setup" mode).  Test results falling within the tolerances are 
color- coded green on the main single-point-test screen.  Those results 
falling outside of tolerances are coded red, and if warning values are 
entered, those outside the warning limit but inside the tolerance are coded 
yellow.

	 Entering or leaving the values of zero will deactivate the Tolerance 
function.  All readings will then be assigned OK status.

	 When the Advanced Statistics Option has been purchased the X-Bar & R 
Chart uses these settings to plot the “high” and “low” test results as red 
points on the graph; “acceptable” test results are plotted as green points.  The operator may also 
set a high/low warning value - those test results are indicated by a gray color on the Advanced 
statistics output.  The “Warning” test results do not affect statistical calculations.    

	 When the "Acknowledgment Required" box is checked  the operator will have to acknowledge 
every time an out-of-tolerance result is produced, by selecting an "OK" prompt.  Also see Section 
3.2.1 for information about prompting comments for out of tolerance results.

	 The "Audible Alarm" checkbox creates an audible signal for the operator to hear when the result is 
out of tolerance.

	 The "Max Axis Difference" is used to adjust the default tolerance setting that controls the 
allowable measurement difference between the two Vickers axes.  Any value other than the 
defaults 20% value may be entered.

		 After setting the tolerance values, select OK to proceed.  
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7) Next the operator is given a chance to update the test parameters: load, time at full load, and the 
high-power camera objective.  It is important to select the same parameters for the scale that the 
tester is using for the testing.  Otherwise, the final measured test result will be incorrect.

	 To change the default values, click on the arrows with your mouse.  A selection of all the possible 
values will appear.  For each scale the operator has selected the available selections that appear 
in these selections for the load, time and magnification will change.

			 

8) Finally the operator has the opportunity to enter a comment.  This comment applies to the entire 
setup file and is used on reports.
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2.2 Open an Existing File

If opening a recent file the operator can select "file" from the main menu then click the name of one of 
the last four opened files which appear on the menu selections.  Otherwise perform the following:

1) Select Open from the File Menu. The Open File dialog box will appear. If the folder C:\MT92VW 
does not appear at the top or if the files have been saved elsewhere, select the proper folder.

2) Open the desired file by double-clicking on the file name from the ones appearing or by typing in 
the file name in the "File Name" box and pressing the "OK" button.

	 NOTE:  If you open a file with another file already open, the current file will be automatically saved 
and closed.

2.3 Close an Open File

1) Select Close from the File Menu.  The file is immediately closed leaving the  program still running 
and on-screen.  The operator may then select a new file or exit the program.
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SECTION 3:  SINGLE POINT TESTING AND MAIN SCREEN FUNCTIONS

3.1 Making Measurements

Making test indentations is done using the tester in the normal manner per the microhardness tester 
instructions.  After the Measure button (optional) is pressed or the first manual measurement line has 
been placed manually, the image of the impression is frozen on the screen (no longer a live image). 
The other lines can be placed or adjustments to the measurement made to the frozen image.  Accept 
the reading or click the right mouse button to return to the live image.  The resulting measurement 
values appear for both the horizontal (H) and vertical (V) scales in microns (see at left) for Vickers and 
in one or the other if setup for Knoop.

3.1.1 Automatic Measuring  [Systems with Auto-measure Option]

(The Measure function is optional in the C.A.M.S. system using HV and HK 
scales and is not present on the linear measurement scales, IN and MM).  
		
Press the Measure button to automatically make a measurement of the Vickers, 
or Knoop impression.  The resulting measurement appears for both the 
horizontal (H) and vertical (V) scales in microns (see at left).  The measurement 
lines appear when the Measure button is selected.  They can be repositioned if 
not positioned properly.  Repositioning is accomplished by clicking and dragging 

the lines or clicking at the proper location for the line.  Press the Accept button to enter the 
reading.   Note: If the impression is not located in the middle of the screen the measurement 
lines may not appear automatically and/or may need to be dragged to the proper locations.

Test result appears after a test 
measurement.  Tolerances and 
converted value appear when 
setup for the current data file.

Appears when the automatic 
turret option is enabled

Appears when the automatic 
cycle start option is enabled

Appears when the screen save 
option is enabled

The functions that appear onscreen depend on selections and purchased options.

Appears when the 
automeasure option is enabled



3-2 3-3C.A.M.S. -  MAIN SCREEN FUNCTIONS C.A.M.S. -  MAIN SCREEN FUNCTIONS

3.1.2 Manual Measuring   [Available on all systems - appearance depends 
on Knoop or Vickers scales and Update button selections]

The measuring lines can be manually positioned without using the Measure 
button.  The operator must make a judgement as to the location of the edges of 
the impression and click the mouse at the top, bottom, right and left when the 

cursor is at the correct position.  

3.2  Result/Tolerance Display [All Systems]

After a measurement has been made the test result appears at the upper 
left part of the screen. Beneath the result will appear the selected tolerance 
limits and after the Accept button pressed a converted test result - if these 
test parameters have been selected. Color coded indications - green, 
yellow, and red - appear when tolerances are entered and the results fall 
within tolerances, within a warning band, or outside the tolerances.

3.2.1 Prompt for Out-of-Tolerance Results [All Systems]

In order to be prompted to enter a comment for out-of-tolerance results, the setup must be 
done when creating a new file.  During the file setup select the Prompted Checkbox from the 
Part Information Field Names and the Acknowledgment Required Box from the Set Tolerances 
screen.  When an out-of-tolerance result is obtained, the operator will be prompted to enter a 
comment in the Part Information Screen.  The comment entered into the top cell of the "Part 
Information" screen will appear in the report next to that result.

3.3 Test Parameter Displays [All Systems]

The selected test load, objective magnification (high power), and test dwell 
time appear at the left of the screen.  Additionally, the measurement axis 
appears at the right side of the screen: "2 AXIS" for Vickers, "H AXIS" or "V 
AXIS" for Knoop.  The operator has an opportunity to establish these values 
when setting up a new file.  Changes can be made through the Update 
button if the operator needs to change any parameters on the data setup file.   

3.4 Status bar [All Systems]

The bottom right corner of the screen has a menu bar that shows the currently selections for:  file 
name, test scale, and test number.  

	
3.5 Clear Last Button [All Systems]

Removes the most recently accepted test results.  This selection acts the 
same as the Data Menu function  - Clear Last Test.
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3.6 Reports Selection [All Systems]

This function is the same as the View menu selection from the top menu.  	
It will display the currently selected reports.  For more details see Section 4.

3.7 Full Screen Mode [All Systems]

	Full Screen mode enables the operator to see the entire screen filled with the image of the test 
specimen with only a little area covered by the most basic operation controls.   

Most of the same controls are for measurements and optionally for moving the tables and focusing (if 
those options are added to the system) as in full screen mode

3.8 Tester Remote Controls [Systems with Automatic Cycle Start and Automatic Turret Options]

The optional Run Test button will initiate the tester to begin making a test impression.  Note: Not all 
testers can have their test cycle initiated 	
automatically.  If the Run Test button is selected the system will make a single 
point test at the position under the crosshairs in the center of the screen.  First 
the system will prompt for the operator to rotate the tester turret so the 
indenter is in the test position.  When the OK is pressed the tester will make a 
test, a window will appear after the test to prompt the operator to move the turret back to the camera 
position.  

The optional "40x", "v", and "10x" buttons are part of the Automatic Turret Option. These buttons 
allow the operator to use C.A.M.S. controls to select the high power objective (in this case 40x), the 
indenter position (v), or the low power objective (10x) on the microhardness tester.  When selected the 
microhardness tester will automatically switch the turret to these positions.  This option can only be used for 
those testers which have an automatic turret option installed and a tester capable of being automated.  
These controls are active whenever they appear.
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3.9 Image Size and Image Capture (Save) 
["SAVE" button appears when Image Capture Option is enabled]

The save function allows the operator to capture the camera image.  The captured image consists of 
the live image without the program controls and buttons appearing.  To capture and image select the 
Save button.  A window will appear to prompt the operator to enter a file name and optionally of full 
path statement.  A screen capture of the camera image will be saved in bitmap format.  The file name 
extension, “.bmp”, is added automatically if the operator does not enter it.  It is saved to the current 
directory or to a different directory if the operator types in a full path name.   This image can be 
printed using most graphics programs.

The Image Size buttons, 1X and 2X, allow the operator to view the image as if magnified at 2X or at 
standard 1X view.  The Image Capture does not work at 2X.
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3.10 Update Test Parameters [Button Appears with all Systems]    
		

3.10.1 Update: Load, Time, & Magnification [Appears with all Systems]

The options at the top left of the screen allow the operator to 
view and change test parameters (to match those set on the 
tester) which are used to determine a hardness value: load and 
magnification.  

In this window the operator can click on the Load, Load Time, or 
the Magnification selections with the mouse to change to another 
option.  A list of all the possible selection for each variable is 
displayed in a drop-down selection.  Changes in these selections 
only change the tester if that option has been purchased.  

3.10.2 Update: Measurement Axes
[Appears with all systems]

Selection for testing Vickers in "2 Axis" or Knoop "horizontal" 
(appearing on main screen as "H AXIS") or "vertical" (appearing 
as "V AXIS")

3.10.3 Update: Line Type [Appears with all systems]

Displays selections for the impression measurement line types. 
Click on each to see which is better in your application

3.10.4 Update: Image Adjustments [Appears grayed 
out in all CAMS systems]

3.10.5 Update: Camera Gain [Appears with systems 
using Auto-measure Feature]

This option adjusts the positioning of the lines.  Adjustment is 
not usually necessary.  To adjust the operator can repeatedly press 
the forward and backward arrows under the horizontal or vertical 
scales.  This will adjust the lines wider or narrower with respect to 
the edge of the indentation.  If the operator wants to make a test to 
check the adjustment, he can press the Measure button to perform a test.  If the gain is not set 
correctly he can adjust it further. 

3.10.6 Update: Camera Shift [Appears with all systems]

This option adjusts the position of the sets of lines (horizontal or vertical) in relation to the edges 
of the indentation.  Changing the values moves the sets of lines left/right or up/down, 
respectively, for the X, Y, or Z (up/down for focusing) axes

Load, Load Time and 
Magnification Parameter 

Updates 
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3.10.7 Update: Color and Width [Appears with all systems]

Use these functions to adjust the way the measuring lines are viewed on the display.  
1) Select Update from the main screen. The Update parameters dialog box will be displayed. 
2) Click on Color button to change line color: green, light blue, red, yellow, black, or blue.
3) Click on Width button to change line thickness: fine, medium, or heavy.  
4) Select OK when done.

3.10.8 Update: Round Correction 
[Appears with all systems with loads over 1kg]

If the selected load in the C.A.M.S. program is over 
1000g AND the round correction checkbox is marked, 
then a round correction factor will be prompted for 
after each test. Options for round correction are 
available for spherical and cylindrical specimens as well 
as concave and convex, and on cylindrical specimens 
when they are oriented at 45 degrees from horizontal/
vertical.

The operator is prompted to enter the diameter of the 
test specimen and the unit of measure,   then prompted 
to accept or reject the converted result.  If the result is 
accepted the most recent selections become the defaults 
for the next round correction.

3.10.9 Update: Calibrate [Appears with all systems]

1) Select the Calibrate button.  Place the stage micrometer on the specimen stage and align it 
on the  display.  

2) Use the mouse to click on the measurement points.
3) Compare the numbers in the measurement window on the right side of the screen to the 

actual dimensions of the stage micrometer. If they are equal the system does not need 
calibration. If calibration is needed, see the following.

4) Select the Calibrate Button.  The next prompt requests which axis to calibrate. 
5) Key in the actual dimension.  Select OK when done.  The number in the measurement 

window on the screen's right side will show the corrected number.
6 ) Repeat the procedure with the second axis if necessary.
7) When finished, select OK to complete the procedure.

3.10.10 Update: Color Camera [Appears with color camera option attached]

The color camera checkbox only appears if a USB camera is not used.  It is designed for use with the 500 
Series Color Camera.
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3.11 Distance Measurement [Appears when inch/millimeter measurement option is enabled]

If "inch" or "mm" is selected as the scale during the test setup, the tester will allow the operator to measure 
distances at any angle.  To make a measurement the operator must select the end points - in both x and y axis.  Start 
by clicking in each quadrant and drag each line that appears to one of the end points so there is a vertical and 
horizontal line at each point.  

The result is as seen below.  The distance between the two crosses is the measurement as indicated 
by the arrows.  It appears at right with x-axis offset, y-axis offset and total distance offset.  It can be 
accepted just like a test  measurement, which will show the result and a converted value (not 
appearing below) at the upper left along with tolerance indicators (if entered).

Quadrant 
1

Quadrant 
3

Quadrant 
4

Quadrant 
2
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SECTION 4  MENU BAR: OTHER FUNCTIONS

For instructions on the File Selection on the Main Menu, see section 2.  
The other Main Menu selections are discussed here.

4.1 View Menu

4.1.1 Advanced Statistics Software 

The View Menu  consists of 6 different functions: Reports, Tile, Auto Tile, 
Tool Bar and Status Bar and Image.  When activated, a check mark will appear in front of the 
function listing.

	Click on View to display the available 
functions.  Click on the individual 
functions to activate.
•  Reports - Shows the data in the 

current file, as well as a histogram 
and X-Bar/R Chart of the data.

•  Tile - resizes and rearranges all open 
windows so that they fill the screen.

•  Auto Tile - opens all windows, and 
automatically resizes and rearranges 
them so that they are restored to the 
original arrangement.

•  The Tool Bar & Status Bar can be 
turned on and off by clicking on 
them.

•  The Image menu selection returns 
the system to the main testing 
screen, as does the Image button at 
upper right.
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4.2 Setup Menu

	The Setup Menu consists of six different functions: Average, Test Setup, Tolerances, 
and Scale Select Communication Setup, and Settings.

4.2.1 Average Menu [Appears when averaging option is enabled]

	The operator may select to record averages of multiple tests 
rather than the individual tests.  The data file must be empty 
to perform or change a Average Mode selections.   If there 
are tests already in the file, the Set Average Group Size 
button will not appear activated.

	To operate the averaging function open a new file or clear all 
data out of an existing file.  Select the first option from the 
Setup menu: Average. Enter a value in the average group size 
box.  After the group size value is entered, some or all of the 
options will be enabled.  

To disable the function enter a "1" value.  Data must be 
deleted from the file to turn off averaging.  The averaging 
functions are as follows.

Keep All - The default setting.  Calculates an average in the normal manner.

Eliminate Highest and Lowest Values		
When 3 or more tests are selected to be averaged the system will remove the highest and 
lowest values from the group average.  For example, if the average is set for 5, then 3 
results will be averaged.  If an average of 2 is selected the function is disabled (see above).

Eliminate furthest from the average
Once the testing is completed the system calculates the average and removes the one test 
that is furthest from that average.  If an average of 2 is selected both values are kept.

Eliminate the furthest from maximum standard deviation - The operator is 
prompted to enter a maximum standard deviation value.  When the testing is done the value furthest 
from the standard deviation allowable is removed.  If all the values fall within the standard deviation 
then none are removed.

When averaging is running, after every set of results 
the report menu will appear showing the averaged 
value and intermediate values in the top window.  The 
X-Bar & R Chart will show a position for the averaged 
value and a line extending through the average value 
indicating the range of the results.  Note: If one of the 
results is selected in the X-Bar & R chart it will have a 
line extending through it from the top to bottom of the 
screen, and in the data the selected result will be 
highlighted.  

Select the Image button to return to test mode.

Average Screen showing 3 
functions enabled.
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4.2.2 Test Setup [Appears with all systems - 
some functions grayed out depending on options]

	The Test Setup is to enter some file parameters that 
apply to reports and data storage.  

	The Company Name box allows for up to three rows 
of data to be input.   This name will appear at the top 
of all the report.  The Top Margin box allows the 
operator to control how many blank lines are entered 
at the top of the form. Work Order/ File Comment box 
which also appears at the top of the printed report.  

	The Network Drive option allows the operator to automatically copy the current datafile to an 
additional location.  The data copy function occurs every time the file is closed 

4.2.3 Tolerances  [Appears with all systems]

The tolerance selection is for changing tolerances in an existing file.  Its 
operation is exactly the same as the initial file setup.  (Refer to the File 
Open section.) 

NOTE: Entering zero values for both will deactivate the Tolerance 
function.  All readings will then be assigned an “OK” status.  Also, once 
a file has been set up with tolerance settings, changing the tolerances 
will affect the statistical calculations for all the test results that have 
been entered to that point. 

When the Acknowledgment Required box is checked the operator will 
have to acknowledge every time an out-of-tolerance result is produced.  
In the Max Axis Difference box the operator can also enter the default 
error-checking value to limit differences in the relative measurement of 
the two axes on the Vickers scale.
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4.2.4 Scale Setup [Appears with all systems - some scales may not appear depending on options]

	This functions is used to select new Primary 
and/or Converted Scale designations.   The 
function is exactly the same as has been 
described earlier under the File Open section

	The scale can only be changed when setting 
up a new file.  Once data has begun being 
collected, you cannot change the scale 
designation for the current open file.  If the 
operator attempts to do so, a dialog box will 
appear prompting you to close the current file.  
To change the scale clear all data from file.

4.2.5 Communications Setup [Appears with all systems]

Communications Setup is used to set the parameters 
of the Serial output for communications with a serial 
printer or to another computer.  At the end of each test 
(when the result is accepted), the information can be 
sent through the serial port. The data string selections 
are Parity,  Data Bits, Data Rate (Baud) and Port.

	Check boxes are provided for the type of output; if the 
entire string of the history data is to be sent to the 
serial port (the same string as it appears in the data 
line) then select "Output All"; if the "Output Result Only" 
box is checked, only the actual value accepted is 
transmitted.  If "Output Off" is selected then no data is 
sent. If the Enable Trace box is checked, the data 
seen at the lower left part of the toolbar in the main 
window (File name, Scale, Test number) is added to the 
test result in the serial output.  

4.2.6 Settings [Appears with all systems]

Settings Menu selection prompts the operator to change the 
load, test time and magnification.  This function is the same 
as is found under the Update button.
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4.3 Data Menu 

	The Data Menu consists of 4 different functions:  Clear Last Test, Clear Test #, 
Clear All Tests, Statistics, and Part Information.

4.3.1 Clear Last Test [Appears with all systems]

	This function is used to clear the last test result from 
memory.  It is the way in which you can delete an erroneous 
reading caused by machine or operator error and not affect 
the statistical calculations.  This is the same as the Clear 
Last button on the main screen

1) Select Clear Last Test from the Data Menu.  A dialog box will  appear asking you if you are sure that you 
want to clear the last test taken.

2) Select the Yes button to delete the last test.

3) If the system is operating with Averaging, the system will prompt whether to remove the 
average from the group

4.3.2 Clear Test Number [Appears with all systems]

	This function is used to clear any of the test results in the 
current file from memory.  

1) Select Clear Test #  from the Data Menu.  A dialog box will 
appear asking the operator to enter the test number.  

2) Enter the number to be deleted.  After the number is entered the operator is prompted to 
verify that it is the proper number.

3) If the system is operating with Averaging, the deleted result will 
be the averaged value, not one of the intermediate values.

4.3.3 Clear All Tests [Appears with all systems]

This function is used to clear all of the test results from the current file.  
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4.3.4 Statistics [Appears with all systems - different screens appear depending on options]

This function provides an on-screen listing of statistics.  The operator can select a range of 
results (at bottom of screen) and the statistics will automatically change to reflect the selected 
range.  "No Cpk" will eliminate this value from the reported information.  Any selected range of 
data can be exported to a comma-delimited .csv file.  If Averaging has been implemented under 
the setup menu, the averaged values and the values comprising the average (up to 5) appear 
under Position 1, 2, etc.  

4.3.5 Part Information [Appears with all systems]

This function provides an on-screen listing of statistics.  The operator can select a range of 
results (at bottom of screen) and the statistics will automatically change to reflect the selected 
range.  "No Cpk" will eliminate this value from the reported information.  Any selected range of 
data can be exported to a comma-delimited .csv file.  If Averaging has been implemented under 
the setup menu, the averaged values and the values comprising the average (up to 5) appear 
under Position 1, 2, etc.  
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APPENDIX A1: VERIFICATION (OPTIONAL)

	 The verification function allows for the verification of the tester according to the Standard used, (ASTM, 
ISO etc.). This is for the indirect verification of the entire system, which includes the load, the indenter and 
the measuring device. (For direct verification of only the measuring device, see the calibration section).
		
In order to use this function, there must be an existing verification file; after the existing file is opened, a 
new file must be created using the existing parameters (see section 2.1,). This sets the system in the 
verification mode and allows the entering of the tolerance limits for error and repeatability  (under the 
tolerance function) as well as the test block information (under Part Information).

The nominal value of the test block must be entered in Vickers or Knoop values, the Max Error and 
Repeatability are automatically calculated according to the appropriate table.

The number of tests to average per verification is entered in the tolerance module, and the average pull 
down  is disabled. 

		
At the end of a series of tests, the report section shows how the verification resulted compared with the 
specified tolerances. The reference used is the nominal value of the block.   Under print preview, the 
history data section shows a  recap of the verification, with a line stating the pass or fail status. This can be 
printed to obtain a certificate.
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APPENDIX A2: GRAIN SIZING (OPTIONAL)

The Grain Size option enables the user to measure the grain size of a sample seen on the monitor.  

The grain sizing option must be setup during the new file 
setup procedure.  After selecting the file name and the 
descriptive information, the operator must select the 
Metallograph Mode radio button and the UM scale [UM 
Stands for "mm" or micro meters or thousandths of a 
millimeter] or the GRSZ scale [indicating "grainsize"].

There are two basic grain measurement methods built 
into the system.  A direct measurement method, called 
Grain Intersects, and three indirect-measurement size-
matching techniques.  When Grainsizing has been 
selected as the scale the operator can toggle between 
measurement systems using ALT-T.  Alternatively the operator can change 
the grain size measurement system using the UPDATE button located on the 
main screen.  The choices are listed in the Line Type section in the graphic of 
the Update functions, seen to the left.  (If the lines types selections are 
different than those seen here, then most likely the operator  has not selected 
the a valid scale for grain sizing during the setup, in which case the standard 
Line type selections are shown for measuring microhardness indentation 
sizes.)

In the direct measurement method, called Grain Intersects, the operator is 
presented with a screen displaying the test sample.  When the operator clicks 
somewhere on the image a line is displayed that runs through that click point 
and the center of the screen.  The operator can drag this line around to the 
best angle when he first clicks on the screen. The operator must click on all 
spots on the line where that  line intersects the edge of a grain.  Any line can 
be removed by clicking on it a second time.  When all the intersections have 
been located, select the Accept button to obtain an average measurement in 
mm.
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To increase the accuracy the operator may select the average function (Located under the Setup Menu 
selection during the file setup procedure).  When the average is setup with "2" selected the operator  
proceeds with a measurement in the regular fashion, but after the first measurement he can strike a 
second line perpendicular to the first and get an averaged result after it is measured (as per the screens 
above and below). The three indirect size matching methods for grain sizing are "Half Pattern", "Full 
Pattern" and "Standard Octagons".  

If "Half Pattern" is selected (see top graphic), the operator can change the scale of the overlay until it best 
fits the grain size of the live image of the sample.  To start click on the screen above and below the center 
mark .  The overlay will appear showing the surface of the test sample on one side without the overlay.  
The "Full Pattern" (See below) allows the operator to get a better view of the overlay since it is full screen.
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To adjust the overlay size click and drag the selection bars  (shown in white above and below the center 
spot on the screen) farther from or nearer to the origin point ( the cross) in the middle of the screen.  As the 
scale selection bar is dragged farther from the origin, the scale of the overlay image increases and vice 
versa.  The "Half Pattern" screen above shows the size scaled larger.  Below the "Full Pattern" has an 
adjustment that shows the size scaled smaller.  When the proper size is reached, select the Accept button 
to confirm the measurement.

The third of the indirect grain size matching methods is "Std. Octagons".  If "Std. Octagons" is selected as 
a method of measuring the grain size (see below), the operator can click at a point approximately 
indicating the top and bottom edges of a grain, which causes selection bars (in white) and octagon shapes  
to appear.  The operator can change the scale of the overlay until it best fits the grain size of the sample by 
clicking  and dragging the selection bars  (shown below in white above and below the center spot on the 
screen) farther from or nearer to the origin point ( the cross) in the middle of the screen.  As the scale 
selection bar is dragged further from the origin point in the vertical axis the scale of the octagon screen will 
enlarge and vice versa.  When the best fit size is obtained, select the ACCEPT button on the right of the 
screen to obtain a test result.
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APPENDIX B: TROUBLESHOOTING

NO PICTURE OR POOR CLARITY (C.A.M.S.‑UNIT)

-Check the bulb for the scope. See your hardness tester operation manual.

-Make certain that system components are plugged in, properly connected and turned on.

-Check the focus on the tester. 

-Check the test head height adjustment

Check all fuses and connections on each of the different components.

PROGRAM WILL NOT PROCEED

-Make certain that system components are plugged in, properly connected and turned on.

CHECKS TO MAKE BEFORE CALLING THE FACTORY

If you run into problems:
1) Reboot the computer
2) Consult the Windows Manual for troubleshooting information
3) Contact Newage Testing Instruments, Inc. Technical Customer Service at 

215-526-2200
FAX: 215-526-2192 
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APPENDIX C: FILE LAYOUT

ilefmt.doc:	  FILE FORMAT, Version 2.0

Line 1:

char FileSignature Version [14];
char Comma;
char RecordCount[5];        // count of records in the file
char Comma;
char RecordLength[3];       // length of fixed-length records
char Comma;
char ExtraHeaderLength[3];  // length of additional header written
char    Comma;
char    AvgCnt[2];
char    Comma;
char    ConvertScale[5];
char    Comma;
char    LoadTime[2];
char    Comma;
char    Flags[5];		
	// Report view mode
char    Comma;
char    Header2Len[3];		
// length of header2
char    Comma;
char    ExtraFieldDefLen[3];
char    Comma;
char    MaxStdDev[7];
char    Comma;
char    Objective[5];       // objective 10x... 100x
char    Comma;
char    Load[7];            // Load in grams or kg.
char    Comma;
char    Ball[4];            // Ball diameter or PIN type
char    CrLf1[2];

Line 2:

char    Scale[5];
char	Comma;
char    Label1[7];          // "LO:"
char	Comma;
char    LoTol[7];
char	Comma;
char    Label2[7];          // "LW:"
char	Comma;
char    LoWarn[7];
char	Comma;
char    Label3[7];          // "HW:"
char	Comma;
char    HiWarn[7];
char	Comma;
char    Label4[7];          // "HI:"
char	Comma;
char    HiTol[7];
char    CrLf2[2];
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fLine 3:

char    FileComment/Work Order[80];	

char    CrLf3[2];

Lines 4 - 13:

char	FieldName[15];
char	Comma;
char	FieldInfo[20];
char	CrLf2[2];

Line 14:

** Data **			
	// header line

Lines 15+:

char	SeqNum[6];
char	Comma;
char	Date[10];		

// "mm/dd/yy"
char	Comma;
char	Time[7];		

// "hh:mm"
char	Comma;
char	ConvertValue[7];// eg. Dia for HB or HRC for HV
char	Comma;
char	Value[7];		

// Average if in average mode

If the test is an average mode test then the following additional
fields are on each line.

char	Comma;
char	Min[7];
char	Comma;
char	Max[7];
char	Comma;
char	StdDev[7];
char	Comma;		

	// will be n comma value pairs
char	IndividualValues[7];// separated by commas
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APPENDIX W: LIMITED WARRANTY

Should Newage Instruments equipment require serve, we will repair or replace, at our option, any part or 
product, which upon examination by a Newage Instruments service technician, shows to be defective in 
material or workmanship. This warranty is extended to the original purchaser only, for a period of one year 
(12 months) from owners date of purchase.

This warranty IS NOT VALID IF THE INSTRUMENT HAS BEEN MODIFIED, MISUSED, OR DAMAGED in 
any way. This includes damage caused by disassembly by any person other than an authorized Newage 
Instruments service technician.
		
Please read all operating instructions supplied with the instrument prior to operation.
		
Newage Testing Instruments, Inc. is not responsible in any way for losses, damage, or other forms of 
consequential damage resulting from equipment failure or improper use.
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